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READ ME FIRST 
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In case you're not familiar with the terminology, 
Read Me First is quite often the name given to a 
computer file that contains important information 
for people to know prior to using an application. 

This section contains some important information to 
help you use this book so we thought we'd start 
with a Read Me First section. 

 

What skills and knowledge 
you will acquire... 

The skills and knowledge acquired in Microsoft Excel 2016 - Essentials 
are sufficient to be able to use and operate the software effectively. 

What you'll need to know 
before beginning this 
course... 

Microsoft Excel 2016 - Essentials assumes little or no knowledge of the 
software. However, it would be beneficial to have a general 
understanding of personal computers and the Windows operating system 
environment. 

 

The objectives of this guideé At the completion of this course you should be able to: 

navigate your way around Microsoft Excel 2016 

create and work with a new workbook 

make changes to data in a workbook 

understand, create and work with formulas and functions  

use font formatting techniques  

understand and use the number formatting features in Excel 

print your workbook data 

apply a variety of page setup techniques 

understand and use Excel's Quick Analysis tools 

share workbooks with other users 

What you get in a chapter... Each chapter begins with a summary page listing the topics covered in 
that chapter. The chapter then consists of single-page topic sheets 
pertaining to the theme of the chapter. 

What you'll need to have 
before commencing this 
course... 

Many of the topics in this learning guide require you to open an existing 
file with data in it. These files can be obtained from your instructor and 

need the product code for this course which is ExcelEssentials. 

As you work through this 
guideé 

It is strongly recommended that you close all open files, if any, prior to 
commencing each new chapter in this learning guide. Each chapter, 
where relevant, has its own set of exercise files and any from a previous 
chapter are no longer required.  

Where to from here... Have a look at the next page which explains how a topic page works, 
ensure that you have access to the exercise files (see above), and you're 
ready to make a start. 
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The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
ï an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

) 
Topic name 

( 
General topic overview provides an introduction to the topic 

' 
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

& 
In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

% 
The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

$ 
The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  
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CHAPTER 1 GETTING TO KNOW EXCEL 2016 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft Excel is a spreadsheet application that is usually part of 
a suite of Microsoft applications, known as Microsoft Office. 

You can use Excel for all sorts of tasks involving numbers such as 
budgeting, sales analysis, forecasting, charting and graphing and 
much more. Excel is a tool used to perform calculations with 
numbers, so virtually any task that requires calculation and number 
crunching can be setup and performed in Excel. 

Before you start creating anything, it is worth taking some time to 
become familiar with the Excel environment and its features. 

In this session you will: 

V learn how to start Excel from the desktop in Windows 10 

V gain an understanding of the Excel Start screen 

V gain an understanding of the Excel 2016 workbook 
screen 

V gain an understanding of how Excel works 

V learn how to use the ribbon to access commands 

V learn how to show and collapse the ribbon 

V gain an understanding of Backstage view in Excel 

V learn how to access the Backstage view 

V learn how to use shortcut menus 

V gain an understanding of how dialog boxes work 

V learn how to launch a dialog box 

V gain an understanding of the Quick Access Toolbar 

V learn how to add commands to the Quick Access 
Toolbar 

V gain an understanding of the status bar 

V learn how to exit correctly and safely from Excel. 

INFOCUS 
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STARTING EXCEL FROM THE DESKTOP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create or edit a workbook, the first thing you 
must do is start Excel. The first time you use 
Excel you will need to open it from the taskbar 
Search the web and Windows bar or the All 

apps list in the Start menu. You can then choose 
to pin it to the Start menu or the taskbar so that 
you can access it more quickly and easily the next 
time you use it.  

Try This Yourself: 

 

Before you begin, ensure 
that your computer is 
switched on and the 
desktop is displayedé 

) 
If there is no Excel icon in 
the taskbar at the bottom of 
the desktop, click on the 
Windows icon in the 
taskbar, as shown, to 
display the Start menu 

( 
Click on All apps to display 
a list of all the apps on your 
computer 

' 
Scroll down to the E section 

Excel 2016 is listed hereé 

& 
Click on Excel 2016 to start 
Excel 

% 
Right-click on the Excel icon 
in the taskbar to display a 
menu of options, as shown, 
then select Pin this 
program to taskbar 

You can now click on this 
icon to open Excel from the 
desktop. This icon will 
remain in the taskbar unless 
you remove ité 

$ 
Repeat step 5 to select 
Close window to close 
Excel 

# 
Click on the Excel icon in 
the taskbar to open Excel 
again 

 

1 
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For Your Referenceé 

To add an Excel icon to the desktop taskbar: 

1. Display the Start menu, then click on All 
apps 

2. Right-click on Excel 2016 

3. Select Pin to taskbar 

Handy to Knowé 

¶ You can start Excel by clicking in the taskbar 
Searché bar, typing excel, then clicking on 
Excel in the list of search results. 

¶ You can pin Excel to the Start menu by 
displaying the All apps list, right-clicking on 

Excel 2016 and selecting Pin to Start. 
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UNDERSTANDING THE EXCEL START SCREEN 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unless you start Excel with a specific data file, 
Excel 2016 will open with the Excel start screen 
displayed. This acts as a gateway into Excel and 
from this initial screen you can choose what kind 

of workbook you want to work with. You can 
choose to work with a recent file, open an existing 
file, or create a new file using the available 
templates.  

The Excel 2016 Start Screen 

In Microsoft Excel your data is stored in a file referred to as a workbook. 

The Excel 2016 start screen is very helpful if you want to quickly access files you have worked on 
recently or create a new workbook file based on one of the available templates (including the default 
Blank workbook template). It acts as a gateway into the program. 

If you have already worked on workbooks, a list of recent files will display below Recent in the green 
pane to the left of the screen. If you havenôt worked on any workbooks yet you can open existing files by 
clicking on Open Other Documents (below Recent in the left green pane). This allows you to open an 
existing workbook file from your computer or OneDrive.  

The right side of the start screen displays thumbnail previews of available templates you can use to 
create a new workbook. It also contains the Search for online templates box, which you can use to 
search the internet for additional templates.  

Templates are simply layouts that have already been created which you can customise to suit your 
needs and then enter relevant data. If you want to start with a clean slate you can choose the Blank 
workbook template ï youôll probably find this is the one youôll use the most.  

In the top right corner of the start screen youôll see information about the account youôve used to sign 
into Windows, as well as commands such as Microsoft Excel Help, Minimise, Restore Down (or 
Maximise) and Close. 

The start screen will only display when you launch the Excel 2016 application directly ï that is, by 
clicking on Excel 2016 in the All apps list in the Start menu, searching for Excel and clicking on it in the 
search results, or clicking on the taskbar icon if the application has been pinned to the desktop taskbar.  

Excel 2016 can also be started by double-clicking on a workbook file in File Explorer. When this occurs 

Excel 2016 will bypass the start screen shown above and open the workbook directly. 
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THE EXCEL WORKBOOK SCREEN 
 

 

 

 

  

 

The Excel screen is made up of several key 
components which are described on this page. 
Some of these components, such as the ribbon 
and Backstage view, are common to all other 

Office 2016 applications so once you know how 
they work you wonôt have to relearn them when you 
use other applications. 

1 

2 

7 

6 

3 
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) 
The File tab is used to access the Backstage view which contains file management functions, such 
as saving, opening, closing, printing, sharing, and so on. There is also information contained here 
such as your document Properties. Options are also available so that you can set your working 
preferences for Excel. 

( 
The ribbon is the tabbed band that appears across the top of the window. It is the control centre of 
Excel. You use the tabs on the ribbon to access the commands that are categorised into groups.  

' 
The active cell is where text, numbers, and formulas will appear when you start typing. 

& 
The mouse pointer is used, amongst other things, to select a cell and make it active. It may 
appear as a large cross, as in this example, as an I-bar, or any number of other forms, depending 
upon its function at that position on the screen. 

% 
The status bar appears across the bottom of the window and displays useful information about 
what is happening in the worksheet. At present it shows Ready which means that Excel is ready to 
be used for your project. 

$ 
The worksheet is like an electronic piece of paper ruled into columns and rows. The worksheet is 
where you type numbers, letters, and formulas to perform calculations. Notice that columns are 
headed using letters of the alphabet (A, B, C, etc.) while rows are designated using numbers down 
the left side. 

# 
The scroll bar indicates your current position in the worksheet and lets you move to other positions 
in the worksheet by clicking or dragging. The arrows can also be used to move through the 
worksheet. 

" 
The View buttons and the Zoom Slider are used to change the view or to increase/decrease the 
zoom ratio for your worksheet. 
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HOW EXCEL 2016 WORKS 
 

 

 

 

  

 

For a new user the Microsoft Excel 2016 screen 
can seem intimidating. However, youôll soon see 
that it is made up of three key areas. The data 
you type is placed on a worksheet. The data 

within the worksheet can be manipulated and 
changed using commands on the ribbon. The 
worksheet is part of a larger entity known as a 
workbook which is controlled on the Backstage. 

The Worksheet 

A worksheet appears as a number of 
rows and columns which form 
squares known as cells. Everything 
you type in Excel is entered into 
these cells. In the simple business 
plan shown to the right there are 
numbers and words entered into a 
worksheet. Formulas are also 
entered that automatically perform 
calculations. The worksheet is part of 
a larger entity known as a workbook 
ï workbooks can be filed away for 
future use or for sharing and can 
also be printed. 

The Ribbon 

When you need to do something with the data in a worksheet, such as format it, colour it, analyse it, 
move it, copy it, and much more, youôll find all of the relevant commands on the ribbon. The ribbon 
has commands organised thematically using a series of tabs across the top. 

The Backstage View 

When you want to do 
something with the data in your 
workbook, such as save it so 
that you can access it again 
later, print it, share it with a 
colleague, send it to your boss, 
protect it from prying eyes, or 
whatever, you will need to 
access the Microsoft Office 
Backstage area of Microsoft 
Excel. The Backstage is 
accessed using the FILE tab 
on the ribbon. Rather than 
offering you commands on a 
ribbon, Backstage occupies 
the entire screen and has a 
series of options down the left 
side. Here the Print option is 
active, and that is why you can 
see a preview of the worksheet 
and a series of print-related 
options. 
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USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ribbon is the command centre for Microsoft 
Excel. It provides a series of commands 
organised into groups and placed on relevant 
tabs. Tabs are activated by clicking on their 

name to display the command groups. Commands 
are activated by clicking on a button, tool or gallery 
option. Everything you could possibly want to do in 
Excel will be found somewhere on this ribbon. 

Try This Yourself: 

 Before you begin ensure 
Excel has started and you 
have a blank workbook 
opené 

) 
Examine the groups on the 
Home tab of the ribbon 

These are the most 
commonly used commands, 
including copy and paste, 
font and number formatting, 
styles and editing... 

( 
Click on the Insert tab 

The commands on this tab 
are used to create tables, 
illustrations, charts, headers 
and footers, text objects and 
symbols... 

' 
Click on Shapes in the 
Illustrations group  

A gallery of shapes will 
appear which can be inserted 
into the worksheeté 

& 
Click on some of the other 
tabs across the top of the 
ribbon (Page Layout, 
Formulas, etc.) and examine 
the commands on them 

Some of these open ñdialog 
boxesò... 

% 
On the View tab, click on 
Zoom in the Zoom group to 
display the Zoom dialog box 

$ 
Click on [Cancel] then click 
on the Home tab 

 

2 

3 

For Your Referenceé 

To use the ribbon: 

1. Click on a tab to display the commands 

2. Click on a button to activate a command, 
display a gallery, or display a dialog box 

Handy to Knowé 

¶ Additional tabs known as contextual tabs 
appear in specific circumstances. For 
example, if you insert a picture, the Picture 
Tools: Format tab will appear. This provides 
quick access to all of the tools you may need 
in order to modify and work with the picture. 

5 

Dialog boxes like this one provide settings or 
options for you to choose from. For example, in this 
one you can zoom the screen by varying 
percentages. We wonôt actually do anything at this 
point. Youôll get plenty of opportunity for using 
dialog boxes at a later stage. 

 
























































































































































































































































